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1. General description

A PX181 touch panel for managing the performance of the configuration saved on a PX140 

control. PX181 is fitted with a colour 5.7" LCD screen with a diagonal of 5.7 " and resolution of 320 x 

240 px. 

As opposed to traditional systems, where the number and the look of control elements is pre-

defined, the touch panel allows the user to have a panel with any number of keys and sliders and to 

set the look and description as well as easily change the settings as needed. 

A PC app supplied along with the panel allows the user to design the look and functionality of the 

panel. The application offers a library of basic graphic designs that can be used but the user can 

also upload their own images.

Additionally, you can protect the access to specific pages of the panel with a password.

2. Safety conditions

  While using the PX181 module, you should at all times obey the rules set forth below:

1. The device can be connected to 12 V DC (stabilised voltage) with current-carrying capacity 

compatible with technical data.

2. All the conductors should be protected against mechanical and thermal damage.

3. In case of damage to a conductor, it should be replaced with a conductor of the same technical 

data and attestations.

4. Connection of DMX signal can be made with a shielded conductor only.

5. All repairs, connecting and disconnecting of cables can only be made with cut off power 

supply.

6. The device should be strictly protected against contact with water and other liquids.

7. All sudden shocks, particularly dropping, should be avoided.

8. The device cannot be turned on in places with humidity exceeding 90%.

9. The device cannot be used in places with temperature lower than +2 C or higher than +40 C. 

10. Clean with damp cloth only. 

Symbols used in this manual:

o o

For the purpose of this manual, this sign implies that information it is associated with 

might have an impact on the safety of the device.

 As used in the manual, this sign refers to a useful piece of information.
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To set the internal panel clock, select a clock icon in the main menu. The page of the clock 

displays the current time of the panel and a button facilitating synchronisation with the PX140 

control.

3. Operation of the device

3.1. Clock

When you switch it on, the panel displays the main menu. The menu allows you to go to saved 

pages or change panel settings.

The device can be used individually by 4 various users. Each user has its own home page. 

The first user has a home page No. 1 ascribed. Other users have home pages with consecutive 

numbers. The access to user's home page can be protected with a password. To navigate to a 

given page, select an icon of a relevant user in the home page window. A message "Error no 

page" displayed on the screen shows that the page with a given number does not exist. 

To change settings, select the settings icon. The settings page shows the panel's firmware 

version, its serial number and buttons enabling the user to change individual parameters.
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3.2. Panel number and home page

You can connect the maximum of 14 panels to the PX140 control. To ensure proper 

communication between the control unit and panels, ID numbers of the panels need to be 

properly configured. By default, each panel has 'ID 1'. In the ‘Change panel ID’ window, you can 

enter a new ID number. 

In the same window, you can also set a home page displayed at the time the panel is switched 

on (instead of the window of the main menu). For that purpose, enter a page number and select 

the 'Auto page ON' option.

The PX140 controller can send signals to panels. You can programme the panel so that it 

responds to signals coming from a Px140 control by displaying an alert or showing or hiding panel 

indicator lights. Irrespective of whether the panel responds to a given signal or not, in the 'Signals 

from PX140' window, you can see all signals coming from the control. While configuring the 

panel, you can add a description to each signal number; if you do so, it will be shown in this list. 

You can display all or just new signals. 

'Accept' and 'Delete' buttons are available for 

each item in the list on an individual basis or 

globally – for the entire list. If you accept an item 

on the list, it will not be displayed in the list of new 

signals; if you delete an item, this item will not be 

displayed on any list.

 

3.3. Signals from PX140

If you switch on the home page, make 

sure to place a button for transition to 

the main menu on one of the pages. 

Make sure you have saved your 

settings before leaving the screen.
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The access to individual users' pages and the screen with settings can be protected with a 

password. To set a password for the screen with settings, select "Admin passw. change" to set a 

password for the user, select "User n passw. change"

Type a new password in the screen displayed. If the password is displayed in the window at 

the bottom of the screen, the password has been set correctly. 

To delete the password, press "enter" on the keyboard without entering any password.

In the 'Screen' page, you can set main brightness of the screen and activate the screensaver 

option. You can set brightness level to which the screen will be dimmed and the time after which 

the screen will be dimmed. 

You can use the slider on the screen to set the main brightness of the screen more easily. 

3.5. Changing passwords

3.4. Screen settings
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4. PC software

4.1. Installation

The PX181 touch panel can be fully configured by means of a PC app. With the app, you can 

set up new pages, move between pages and also programme interactions with the PX140 

control. 

During the configuration, the touch panel does not need to be connected to the computer, you 

can save your design on the hard drive and load it to the device at any time. 

You can install the app on any computer with the the XP/7/8 version of the of Windows operating 

system. The installation process is very easy and consists of just 6 steps.

1. Select a language – you will be asked to select a language in which the installation process 

will be completed.

2. Licence – to continue, the user needs to accept the terms and conditions of the licence 

agreement.

3. Selection of components – the user can choose to install the application and a USB driver. If 

you do not install the USB driver, it will not be possible to connect the application to the 

panel.

4. Selection of an installation folder – the user can change the default folder for component 

installation (however, it is recommended not to change the default settings).

5. Selection of the Start Menu folder – the user can specify a Menu Start folder of the system in 

which the application will be installed (it is recommended not to change default settings).

6. Completion – after the installation process having been successfully completed, the user 

can press the "finish" button. 

The application will be ready to use.
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4.2. Application window.

The window of the application consists of 6 basic areas:

       Main menu – access to all functions of the;

       Item area – configuration of an item marked;

       Pages area – a list of all pages and items located within those pages;

       Preview – a preview of a page marked within the pages area;
       
       Quick access bar – quick access to the most frequently used functions;

       Status bar – information about the connection with the panel.
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4.2.1. Tool bar

The tool bar is a roll-up menu consisting of the following categories:

File contains basic options of the project:

- New project: creates a new, empty project;

- Load: opens the pre-saved project;

- Save: saves a created project as a file;

- LoadPage: opens a pre-saved page;

- SavePage: saves the current page as a file;

- Add configuration: adds pages from the selected configuration to the current configuration;

- Save configuration to PDF: saves pages and relations between them as a PDF file (section 

4.5).

Add is used to create new elements:

- Button (Section 4.3.1);

- Slider (Section 4.3.2);

- Alert (Section 4.3.4);

- Clock (Section 4.3.5);

- Page (Section 4.3);

- Add Control (Section 4.3.3);

- SnapToGrid;

- SetXGrid;

- SetYGrid;

Px181 USB serves communication with the panel:

- Save AllPages: saves all pages created within the panel;

- SaveCurrentPage: saves the presently created page within the panel;

- GetConfigurationFromPanel: loads a configuration saved in the panel to the application;

- PX140 signals: opens a window in which you can add descriptions for signals coming from 

the driver (Section 4.4);

- Firmware upgrade: updates software in the panel (Section 4.6);

- Password clear: clears admin's and users' passwords set in the panel.

Language changes the language of the application (the change forces the app to restart).

Help displays information about the current version of the app and the producer's contact details.
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The preview window displays the 

currently selected page.

You can select items shown there by clicking 

the left mouse button.

You can move an item anywhere you want by 

simply dragging it.

To change the size of an item, drag its 

right bottom corner.

Context menu

Upon clicking the right mouse button in 

the preview area, a context menu will pop up. 

You can use it to:

- Add items to the page;

- Add a page;

- Change the graphic design of the background;

- Save the page as an image;

- Turn on the "snap to grid" feature;

- Set the size of the grid in X and Y axes

4.2.2. Status bar

The status bar displays information about connection with the device. The panel connects 

with the app automatically upon being connected to the computer. If the app does not detect the 

device, this will be announced with a message "USB PX181 Disconnected." If the application 

detects a device, then the message "USB PX181 Connected," a series number of the panel and a 

number of the firmware installed will be displayed.
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4.2.3. Preview

To select a group of items, click on 
each while holding the Ctrl button.

In the case you want to bring an item 
outside the working area, it will be 
moved along the shortest route to the 
edge of the desktop area.

zaznaczanie

rozciąganie



After activating the application, the first page will be created by default. You can add other 

pages by:

- Selecting "Add" -> "Page" in the tools bar;

- Selecting "Add Page" in the quick access bar;

- Clicking the right mouse button on the list of pages and selecting "Page" from the context 

menu;

- Clicking the right mouse button on the existing page in the list of pages and selecting 

"Duplicate page" from the context menu.

A new page is added with a default background and the next number available. You can 

change the page number by clicking the right mouse button and selecting "Change page number" 

in the context menu.

All pages created are shown on the list of pages. You 

can edit each of them by selecting a given page. An active 

page is displayed within the preview window. 

On each page, you can add buttons, sliders, indicator 

lights, alerts and clocks. The preview window allows you 

to arrange the items located on the page. To have an even 

arrangement, you can activate the "snap to grid" feature 

("Add" -> "SnapToGrid"). The size of the grid (separately 

for axes x and y) can be adjusted within the 1-160x range. 

The grid is invisible, even if active.

The pages area includes a list of pages created within 

the application. It enables convenient navigation 

between pages you want to edit. If you click "+" on the 

page name, the list will pop up showing all items located 

on a given page. If you click the name of a given item on 

the list, that item will be automatically selected within the 

preview window.

4.3. Creating a page
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You can explore the area of pages also by means 
of arrow keys. The "Up" arrow moves what is 
selected upwards and opens a page selected; the 
"Down" arrow moves what is selected downwards; 
the "Right" arrow rolls up the tree, and the "Left" 
arrow rolls down the tree.
Upon selecting a given page and pressing the right 
arrow key, the content of the page will be 
displayed. If you press the left key over the same 
position, the content of a given page will be rolled 
down.
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To change the background of a given page, you need to select that page and click the right 

mouse button within the preview window, and then select "Change background" from the context 

menu that will appear. A graphic file selection window will pop up. The recommended resolution of 

the file is 320 x 240px. 

To delete a page, click the right mouse button on it and select "Delete" from the context menu 

or otherwise select the page and press the "Delete" key.

Context menu

If you click the right mouse button on a page on the list, a context menu will be displayed that 

includes a compilation of the most frequently used functions.

- Delete - deletes a page;

- Change page number - changes page number;

- Show page in PX181 - if the panel is connected to the application, this feature allows you to 

display a page with this number on the panel;

- Duplicate page - creates a page with the same parameters and the same content;

- SaveCurrentPage - sends a selected page to the panel;

- Button - adds a new button to the page;

- Slider - adds a new slider to the page;

- Alert - adds a new alert to the page;

- Page - adds a new page.



- Action in PX140: this feature allows you to select an event pre-programmed on the PX140 

control that will be triggered with a press of a button. Available options:

- DMX Input Slot - 1 On: a range between 1 and 512;

- DMX Input Slot - 1 Off: a range between 1 and 512;

- Internal Event: between 2 and 1024;

- Sunrise Time Event;

- Sunset Time Event;

- Time Event: a range between 3 and 1024;

- Power ON Event; 

- DMX Output Slot - 1 On: a range between 1 and 512;

- DMX Output Slot - 1 Off: a range between 1 and 512;

- Delay: a range between 1 and 512;

- Remote Key 1 - pressed: a range between 1 and 64;

- Remote Key 1 - repeated: a range between 1 and 64;

- Remote Key 1 - released: a range between 1 and 64;

- Input: 1 On: a range between 1 and 24;

- Input: 1 Off: a range between 1 and 24;

- No Action: no action at all.

- 3 colour sliders (RGB) – you can set brightness of each colour component of an object within 

the range between 0 and 255, which changes the colour of an item or its brightness.

- Font: fields enabling you to select a font, size and colour of a button description;

- Text: add a description of a button;

- Bitmap: you can change the graphic design of a button;

- Remove Bitmap: delete the graphic design of a button.
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If you have created a link to a page 
and assigned an Event to a button, 
the Event will be triggered and the 
panel will go to a given page. If you 
set up a link to the Main Menu and 
an Event, then you will be 
redirected to the Main Menu only.

If you set all sliders to ‘0’, the colour of the graphic design will be black, and if you set 
them to 255, the original colour will be restored.



A button allows you to trigger a given event on the PX140 control or navigate between pages 

on PX181. You can assign any picture and text to a given button (the colour of an image may also 

be modified). You can add buttons in a few ways:

1. Choose "Add" -> "Button" in the toolbar;

2. Choose "Add button" in the quick access bar;

3. Click the right mouse button in the preview window and select "Add button" 

from the context menu;

4. Click the right mouse button on the list of pages and select "Button" from the context menu;

5. Select an existing button and press the following combination of keys: Ctrl+C, Ctrl+v

Within the item area, you can modify 

the properties of the button highlighted.

Available parameters:

- Width and height: fields that allow you 

to change the dimensions of a button;

- Position X and Y: you can see the 

position of the upper left corner of a button;

- Page Link: a field where you can set 

up a link to another page of the panel. 

Available features:

- Don’t change any page: the button does 

not trigger any action;

- Main menu: the button will bring you to 

the main menu of the panel;

- Send action: the button will trigger an 

event on the PX140 control;

- Go to page (1 - 99): the button will bring 

you to another page of the panel;

You can highlight several items (by 
holding the Ctrl button) and enter 
a common value of a given 
parameter for all of them.

13

4.3.1 Buttons



The slider allows you to trigger an event on the PX140 control and to send a value to it. This 

feature allows you, e.g., to control the brightness of the lamp in a smooth way. An event is 

triggered upon each change in the value of the slider. 

You can add a slider to the page in the same way as you do with a button. In the area of the 

object, you can modify properties of the slider.

Available parameters:

- Slider Width and Height: fields allowing 

you to change the dimensions of the 

slider,

- Position X and Y: fields allowing you to 

determine a position of the upper left 

corner of the slider

- Orientation: vertical and horizontal orientation,

- Action Number: you can select an event programmed on the PX140 controller that will be 

triggered with the slider. Available options - the same as for the button.

- 3 colour sliders (RGB) – you can set brightness of each colour component of an object within 

the range between 0 and 255, which changes the colour of an item or its brightness.

4.3.2. Sliders

If you set all sliders to ‘0’, the colour of the graphic design will be black, and if you set them 
to 255, the original colour will be restored.
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You can highlight several items (by 
holding the Ctrl button) and enter 
a common value of a given 
parameter for all of them.



An control light responds to specific signals coming from the PX140 controller. Each control 

light has 2 kinds of statuses (ON and OFF) - each status is ascribed to a different colour and a 

different controller signal number that triggers this status. By default, upon switching the device 

on, all control lights will be ON.

Available parameters:

- Width and height: fields that allow you to 

change the dimensions of an control light;

- Position X and Y: you can determine the 

position of the upper left corner of an control 

light;

- State "On": the fields that let you 

determine a signal to which the control light 

should respond by switching on and which 

colour it is supposed to display;

- State "OFF": the fields that let you determine a signal to which the control light should 

respond by switching off and which colour it is supposed to display.

4.3.3. Control lights
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An alert responds to all signals coming from the PX140 control. By default, the alert is 

invisible. Upon receiving a signal from the control, a symbol of an alert will be displayed. If you 

click the alert symbol, a list of signals will be displayed. The symbol of alert will be displayed until 

you have confirmed or deleted signals on the list. If you decide to leave the list of events, you will 

return to the page where the alert appeared. You can set both the position and dimensions of the 

alert.

4.3.4. Alerts

You can highlight several items (by 
holding the Ctrl button) and enter 
a common value of a given 
parameter for all of them.



The PX140 control can send signals with numbers between 0 and 255 to the panels. You can 

add descriptions to the signals so that you can always make sure how they work. For that 

purpose, select "PX181 USB" -> "PX140 signals" from the toolbar. A new window will be opened 

where you can set up descriptions for each of the signals. 

The "Get Signal Description" button lets you load descriptions pre-saved on PX181. The "Set 

Signal Description" button lets you send a list of descriptions entered by the user to the panel. The 

descriptions of signals are sent irrespective of other configuration.

The layout of pages created, transitions between the pages and events triggered by individual 

items can be exported to a PDF file. To do so, select "File" -> "Save configuration to PDF” in the 

toolbar. A preview window will be opened where you can highlight elements to be a part of the 

PDF file.
- Show events - this feature adds a description of an event for each item that triggers the 

event;
- Show Events Icons - this feature adds an icon symbolising a type of event for each element 

triggering an event;
- Show links - this feature adds a line to a given page for each item that triggers transition to 

another page; 
With the "Print PDF" button, you can save the file onto the hard drive.

4.4. Descriptions of signals

4.5. Export to PDF
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You can insert on a page a clock showing the current time on the Px181. 

You can also set the position and dimensions of the clock.

4.3.5. Clocks



To update the firmware, select "PX181 USB"-> "Firmware upgrade" from the toolbar. 

The update window will be displayed. After a short while, the "Get Update file" button will be 

active. Click on the button and select a select a file with an .upg extension from your hard drive. 

Confirm your selection to commence the updating process.

It is normal for the panel to flicker while the firmware is being updated. During the firmware 

update, all settings and files loaded to the panel will be removed.

4.6. Firmware update

The latest update files are on the manufacturer's website: www.pxm.pl.
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While using the device, obey safety rules at all times; in particular, do not disconnect the 
device from power supply, as it may damage the device.

4.7. Loading data from your computer

You can load your panel configuration to the panel at any time. For that purpose, connect the 

panel to the computer using the USB cable. The status bar will display information that the 

application has been connected to the panel. 

Open the desired configuration within the application and then select "PX181 USB” -> 

”SaveAllPages” or “SaveCurrentPage” from the menu. The progress bar shows the number of 

items successfully sent to the panel. It may take quite a while to send an extensive configuration 

with a number of pages. 

If you made only small changes to the configuration that has been already loaded to the panel, 

it is better to use the option of sending the current page in order to save your time.

While sending the entire configuration, the application deletes the previous configuration 

from the panel; however, when the process has been completed, you need to go to the main 

menu or restart the panel to refresh the view.



5. Connecting the device to the computer

To connect this device to the computer, please remove the frame mounted with two screws. 

Plug the cable into the USB socket underneath. 

If the panel is connected to the computer for the first time ever, the operating system will run a 

standard "new device" installation. The panel connected to the computer will be detected and the 

system will automatically activate a wizard searching for new equipment.

If the system asks you if you want to access the Windows Update website to find new 

software, select "Do not connect" and manually indicate a folder to which you want to install a 

USB driver.
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The driver for the touch panel is located in the directory where the configuration application 

was installed. By default, it is the Program Files -> PXM -> Px181 -> usb_driver directory. 

When the driver has been successfully installed, the configuration application will display Usb 

Px181 Connected. in the status bar.

1

2



6. Dimensions of the device
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The device has a concealed mounting box and a front frame to be attached to the box with two 

screws. 
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7. Assembly

The device consists of 3 parts to be connected using screws.

      Concealed mounting box

      Panel body  

      Frame

Attach the concealed mounting box     to the wall by means of 4 assembly screws (see the 

positioning of the screw holes on the previous page). When the box has been mounted within the 

wall, attach the panel body to it     . To that end, use the 4 screws shown in the picture below. The 

last step is to attach the frame       with 2 screws.
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8. Connection procedure
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The PX181 touch panel is a touch device designed to work with the PX140. The PX140 

control must have the option "Enable communication with external panels" turned on. A scheme 

of connections between multiple PX181 panels and the PX140 control is visible below:

23

Connection scheme of multiple Touch Panels to PX140
on next page:

e.i. 120 Ohm resistor 
(connected between 

DMX+ and DMX- lines)
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PX 181

Max. 14 of PX181s

PX 181 PX 181

Scheme connection of multiple panels PX181 and Px140 controller:

The panels should be connected on a serial basis, with the last panel being finished with a 120 Ω 

terminal (insert a resistor with 120 Ω resistance between the positive pin and the negative pin).

Even if you want to connect just one PX181 panel to PX140, it is necessary to insert the 

120Ω terminal.

GND

terminator
(resistor 120 Ohm)

terminator
(resistor 120 Ohm)

For communication between PX140 and PX181 and also between touch panels connected in 

series, use screened twisted pair cables with impedance of 120 , e.g.

• RS 485 LAPP UNITRONIC® LiYCY (TP) paired 2 x 2 x 0.14

• LI2Y(St)-CY 1x2x0,22mm2 120 

For the purpose of connecting the device, you can also use a twist cable and, in that case, 

you need to connect the white-and-orange colour of the cable as a plus (+), and the orange 

colour as a minus (-); and the white-and-brown colour as the screen.

Ω

Ω

DMX  OUTREMOTE CONTROL DMX  IN EXT CTRL

+ + + -- - 
12-24V DC

+5 V input 121110 151413

6 1 3 8 4 5 7 24 9216 17181920 21 2223

PX 140

Architectural
Lighting
Controller

USB LINK

DMX OK

POWER

www.pxm.pl

GND GNDGNDGND
GNDGNDGND+ - 

GNDGNDGNDGNDGND GND GND GND

The view of the terminal block
on the back of the PX181 casing

cables between the controller
and the panel should be connected

in the correct order accordance 
with the designations

 EXT CTRL on PX 140 
and PX 181: + to +, - to -

and GND to GND
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Power supply

Max. power consumption

Casing

Frontal plate

Weight

Screen size

Screen resolution

Connection with PX140

212V DC (min. cable cross-section 0.5 mm )

4W

Steel

Anodised aluminium 

1,2 kg

5,7“

320 x 240

Screened twisted pair cable with 120Ω impedance, e.g.
RS485 LAPP UNITRONIC® LiYCY(TP) pair 2x2x0.14

GND

GND

GND GND GND

The scheme of connection between the PX181 panel and the PX140 control:
(shown on the concealed mounting box of the panel)



26

PXM Marek Żupnik sp. k.

ul. Przemysłowa 12
30-701 Kraków, Poland

PANEL DOTYKOWY

PX 181

PN-EN 55103-1:2012
PN-EN 55103-2:2012

The connection of the DMX signal must be 
executed by means of a screened cable, connected 
with a GND pin.

mgr inż. Marek Żupnik.

DECLARATION OF CONFORMITY
according to guide lines 2004/108/WE

tel:  +48 12 626 46 92
fax: 12 626 46 94+48 

e-mail: info@pxm.pl      
http://www.pxm.pl

ul. Przemysłowa 12
30-701 Kraków, Poland

Theater & stage consoles digital dimmers dmx system architectural controllers          LED LIGHTING                                                                         

Manufacturer's name:

Manufacturer's address:

We hereby declare that our product:

Name of the product:

Code of the product:

complies with the following standards:

EMC:

 

Additional information: 

Kraków, 14.05.2012


